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Using PivotTables 
The PivotTable is one of the most powerful features in Excel. The PivotTable lets you summarize or 

cross-tabulate large amounts of data by selecting fields for rows and columns and performing a 

summary function on the intersections of the row and column fields. 

PivotTables are frequently used to analyze large volumes of data, which are usually found in 

corporate databases. When doing this kind of analysis, you almost always find values that repeat in 

many data records or rows. The various repeating values can be paired in various combinations to 

reveal underlying trends with sudden clarity. 

Creating a PivotTable 

The PivotTable Field List task pane controls the structure of the PivotTable. You use this task 

pane to decide what column data (from your source data table, now referred to as fields) to use as 

the column labels, row labels, PivotTable values, or report filters. 

 

Report Filter Select (or filter) rows of data from the source data to appear in this PivotTable. 

Column 

Labels 

Display fields in this list as columns across the top of the PivotTable. 

Row Labels Display fields in this list as rows down the PivotTable. 

Values Summarize fields in this list box in the main body of the PivotTable. The default 

summary function is SUM, although it can be changed to other functions, such as 

AVERAGE, MIN, and MAX.  

Excel allows you to put more than one column from the source data into each list box in the 

PivotTable Field List. 
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1 Open the Sales workbook and save as Sales PivotTable – Student. 

2 Select a cell within the cell range A1:E2002. On the Insert tab, in the Tables group, click 

PivotTable. 

 Excel displays the Create PivotTable dialog box. In this dialog box, you select the source of the 

data and whether to put the PivotTable on the current worksheet or a new one. You can create 

PivotTables from data in a single range, multiple ranges, external data sources, or even other 

PivotTables. 

 If you select an external data source, Excel starts Microsoft Query to create a query that will 

retrieve the data for the PivotTable. 

  

3 Click OK. 

 The skeleton PivotTable is now ready. Notice that Excel has created it in a new worksheet.  

You can now create a summary that will display the total quantity of each item purchased by each 

purchaser. 

4 Click the check box for the Amount Paid and Payment Type fields in the PivotTable Field List 

to turn them on and indicate that they are to be used in the PivotTable. Excel does not know 

exactly where you will want to place these fields, so for now it takes a guess. 

Learn the Skill 

This exercise demonstrates how to create a PivotTable. 
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By default, Excel places columns containing text data into the Row Labels list and those 

containing numeric data into the Values list. Also by default, it applies the SUM function to the 

columns in the Values list box.  

Add another column containing text data to the PivotTable. 

5 Click the check box to turn it on for the Sale Type field. 

With the addition of the Sale Type column, the PivotTable is 

now much bigger. However, you will notice that the same 

payment type (e.g. Amex, Mastercard, Visa) labels are 

repeated under each of the sale types (e.g. bike tour, car 

rental). 

This table would make more sense if the payment type labels 

and values were pulled across the columns. 

 

6 In the PivotTable Field List task pane, click and drag the Payment Type field from the Row 

Labels list box to the Column Labels list box. 

7 Click a cell outside of the PivotTable to close the PivotTable Field List task pane and view all 

of the data. 

You can also drag the 

fields directly from 

the field list in the top 

half of the PivotTable 

Field List task pane to 

the list boxes located 

in the bottom half. 
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Now remove some of the field values from the PivotTable. 

8 Click the Column Labels AutoFilter button in the PivotTable. 

  

9 Click the Air Miles and Cash check boxes to turn them off, and click OK. 

 These two columns no longer appear in the PivotTable. Notice that the Grand Total amounts 

appearing in the far right have also been adjusted to include only the columns appearing on the 

screen. 

10 In the PivotTable Field List task pane, click the dropdown button on the far right of Sum of 

Amount Paid in the Values list box and click Value Field Settings. 
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11 Click Number Format. 

12 In the Format Cells dialog box, select Number in the Category list. 

13 Reduce the Decimal places to 0 and click Use 1000 Separator (,) to turn it on. Click OK. 

14 Click OK to close the Value Field Settings dialog box.  

 The worksheet should now look something like the following image. 

  

 The PivotTable Field List task pane automatically turns itself on and off 

when you select a cell inside or outside the PivotTable. 

15 Click any cell inside the PivotTable to display the PivotTable Field 

List task pane.  

16 Save the workbook. 

The PivotTable Field 

List task pane can also 

be turned on or off 

using the Ribbon. Under 

PivotTable Tools, on 

the Options tab, in the 

Show/Hide group, click 

Field List to toggle it on 

or off. 
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Creating a PivotChart 

The data displayed in a PivotTable can be put into a chart, which is referred to as a PivotChart. 

Despite its special name, it really is nothing more than a regular chart that is tied to a PivotTable. 

 

A PivotChart can be created from a PivotTable or directly from source data. If you create a 

PivotChart directly, Excel creates a PivotTable in the same worksheet because each PivotChart 

must be linked directly to a PivotTable. 

 

 

 

1 Select the Sales PivotTable – Student workbook. If necessary, select the Sheet4 tab where the 

PivotTable is located. 

2 Select any cell in the PivotTable. 

3 Under PivotTable Tools, on the Options tab, in the Tools group, click PivotChart. 

  

4 Select the Stacked Column chart in the top row, second from the left of the Column section, 

and click OK. 

  

Learn the Skill 

This exercise demonstrates how to create a PivotChart from an existing PivotTable. 
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5 Move the PivotChart to a new position below the PivotTable. Resize the chart to the same width 

as the PivotTable. 

  

 The PivotChart is linked directly to the PivotTable. Any change made to the PivotTable causes 

the PivotChart to change as well. 

6 Click the Column Labels AutoFilter button. 

7 Click the Air Miles and Cash check boxes to turn them back on and click OK. 
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 Excel changes the PivotChart to reflect the change in the structure of the PivotTable. 

  

 Because a PivotChart is essentially a chart (even though it is directly connected to a PivotTable), you 

can format it like any other chart. 

8 Click anywhere in the PivotChart to select it. 

9 Click on each of the tabs in the Ribbon under PivotChart Tools and view the options available in 

each tab. 

10 Save the workbook. 

Manipulating PivotTables 

According to the Merriam-Webster Dictionary, a pivot is “a shaft or pin on which something turns” or 

“a person, thing, or factor having a major or central role, function, or effect.” An Excel PivotTable is 

both because it allows you to rotate and filter data in different ways so that you can gain a better 

understanding of it. 

PivotTables completely change the way you analyze data—almost to the point of making it fun! You 

can change the way data are filtered, grouped, and/or summed together in a matter of seconds, 

even though the volume of data may be very large (as you have seen in these exercises). 
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1 Select the Sales PivotTable – Student workbook and select the PivotTable on Sheet4. 

First, clear any AutoFilters that may be turned on. 

2 In the PivotTable, click the Column Labels AutoFilter button, and click Clear Filter From 

“Payment Type” if necessary (i.e., if it is not grayed out). 

Flip the positions of the row and column labels and data. 

3 In the PivotTable Field List task pane, click and drag the Payment Type field from the Column 

Labels list box to the Row Labels list box. 

4 Click and drag the Sale Type field from the Row Labels list box to the Column Labels list box. 

Add the Date and Customer No. fields to the PivotTable, and select the data for one customer. 

5 In the PivotTable Field List task pane, click the check boxes for the Date and Customer No. 

fields to turn them on. 

6 Click and drag the Date and the Customer No. fields to the Report Filter list box. 

7 In the PivotTable, click the drop-down button at the far right of the Customer No. field, select 

customer 300, and click OK. 

  

The PivotTable and PivotChart now show only the data for customer 300: 

Learn the Skill 

This exercise demonstrates how to manipulate a PivotTable in various ways by 
moving fields around, as well as how to apply the PivotTable autofilter and change 
the summation function. 
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Restore to all customers and then select the data for one date of the year. This will show you your 

total business volume for that one day. 

8 In the PivotTable, click the drop-down button at the far right of the Customer No. field, select 

All, and click OK. 

9 Click the drop-down button at the far right of the Date field, and then scroll down, select 1-Apr-

11, and click OK. 

Now find out how all of your customers are paying for their travel. To answer this question, you need 

to count up the number of times each payment type was used over the course of the year. 

10 In the PivotTable, click the drop-down button at the far right of the Date field, select All, and 

click OK. 

11 In the PivotTable Field List task pane, drag the Sales Type field to the Report Filter list box. 

12 In the PivotTable Field List task pane, click the Sum of Amount Paid drop-down in the Values 

list box and click Value Field Settings. 

13 Select Count in the Summarize value field by list box and click OK. 
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 The completed PivotTable (and the linked PivotChart) now look something like the following 

screen. 

  

This exercise has demonstrated a very small sample of what you can do with PivotTables. Try 

different combinations of your own; you will be impressed by Excel’s power to help you accomplish 

large and complex tasks quickly and with relatively little effort. 

14 Save this workbook. 



Prepared by PowerConcepts Ltd. 2013 www.powerconcepts.ca Page 13 

 

Using the Data Slicer with a PivotTable 
As demonstrated in the previous exercises, filters are an integral part of PivotTables. However, it is 

not always apparent what the filters select. With Excel 2010, Microsoft introduced data slicers (or 

just slicers) that you can use with PivotTables to help you easily determine which filter conditions 

are currently active. 

Look at the following screenshot. 

 

In this PivotTable, four slicers are active. For the Sale Type slicer, four values are selected, and for 

the Payment Type slicer, three values are selected. The filters for the Date and Customer No. 

slicers are not active because the Clear Filter icon in the upper-right corner of these two slicers is 

grayed out. These filter selections are reflected in both the PivotTable and PivotChart. 

Slicers also allow you to change your filter options very quickly: you simply click on the desired 

buttons in the slicers to turn them on or off. 
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1 Select the Sales PivotTable – Student workbook and save it as Sales PivotTable Slicers – 

Student. Be sure that you have selected the Sheet4 worksheet. 

First change the PivotTable back to display the sum of payments for all sales. 

2 Select any cell inside the PivotTable to activate the PivotTable Tools tabs in the Ribbon. 

3 In the PivotTable Field List task pane, click and drag the Payment Type field from the Row 

Labels list box to the Column Labels list box. 

4 Click and drag the Sale Type field from the Report Filter list box to the Row Labels list box. 

5 Click the Count of Amount Paid drop-down in the Values list box, and click Value Field 

Settings. 

6 Select Sum in the Summarize value field by list box and click OK. 

Insert the slicers for this PivotTable. 

7 Under PivotTable Tools, on the Options tab, in the Sort & Filter group, click Insert Slicer. 

8 Click the check boxes for Date, Customer No., Sale Type, and Payment Type to turn them 

on, and click OK. 

  

9 Move the slicers to an empty area to the right of the PivotTable. 

Learn the Skill 

This exercise demonstrates how to activate slicers for a PivotTable and use them to 

apply filters. 
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10 Click on individual buttons of your choice in any of the slicers, and observe the effects on the 

PivotTable. 

11 Hold down the  key to select (or deselect) more than one button in a slicer. 

12 Click the Clear Filter button in the upper-right corner of any slicer to select all the values in that 

slicer. 

When you no longer need a slicer, you can remove it. 

13 Click on the Date slicer and press . 

14 Right-click on the Customer No. slicer and click Remove “Customer No.”. 

15 Save and close the workbook. 

 

 


